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Copyrights
 AND Technology Ltd., Oxford 1997
 AND Mapping B.V., Rotterdam 1997 (digital mapping data)
All rights reserved, AND Technology Ltd. No part of this publication may be copied, 
stored in a database*, changed or publicised, in any way or form whatsoever, without 
the prior written permission of AND Technology Ltd.

The purchaser of this product is granted a non-exclusive single user licence for use of 
the software on one PC.

* with the exception of data needed to run the application and calculate routes



Introduction
AND Route '97 is a route planner for the road user, providing you with the means to plan 
road journeys between thousands of locations and display them in a clear map. The 
program also offers a number of additional features which further simplifies use of the 
application: AND Route `97 allows you, for example, to select the road network of your 
choice and to include intermediate locations within a journey.

Within seconds of your selection of a departure and arrival point , AND Route '97 
provides the optimal route, as well as providing a maximum of two alternative routes. In 
addition to the departure and arrival point, you can select one or more locations along 
the route which you want to visit on your way. The program will then calculate the 
optimal route (with possible alternative routes) from the departure to the arrival point via 
these additional locations.

The route information consists of the names, or numbers, of the roads, the crossings 
and exit ramps along the route with their numbers, the length of the route in miles, the 
distance between various places and exit ramps along the route, and the approximate 
duration of the journey. AND Route '97 also allows you to determine the amount of detail 
in which this information is presented.

The optimum route is graphically displayed on a map, with any alternative routes also 
highlighted . The map offers a variety of interesting extra features: in addition to 
providing you with insight into the geographical course of the journey, arrival and 
departure points can be selected via the map, as well as other locations in the nearby 
vicinity . The application also allows you to zoom in on the map in order to obtain more 
detail, or to zoom out to obtain a better overview.

Additional information about AND Route '97, where applicable, can be found in the 
'readme' file on the CD-ROM. .
This manual is provided for use with all AND Route '97 road networks.



Conventions
AND Route '97 commands can be executed using Alt-<letter> key combinations. The 
letter to be used to carry out each of the commands is always underlined in the 
application. Alt-F, for example, takes you to the File menu of the Menu bar. A number of 
commands can also be carried out using quick keys, such as opening files (Ctrl+O), or 
printing information (Ctrl+P). The quick keys are displayed in the various menus after 
the corresponding menu commands.
System keys such as the Tab key and the Enter key are displayed between angular 
brackets in this manual. Whenever you see either <Tab> or <Enter> in the instructions 
in this manual, press the appropriate key to carry out the command in question. Text 
which must be typed in is displayed in bold print.



The Main window of AND Route '97
The following illustration displays the Main window of AND Route '97:

The Title bar contains the name of the application, 'AND Route '97', and the road 
network which is currently active.

The Menu bar contains various menus containing all of the AND Route commands and 
options. Descriptions of the menu commands can be displayed on the Status line (see 
Status line) by placing the mouse cursor on the command desired. A complete overview 
of AND Route '97 functions is provided in the section The Menu bar.

The Input fields for the departure and arrival points can be found under the Menu bar, 
along with the Work bars containing most Menu bar functions. A single click activates 
the underlying functions. Work bar buttons which cannot be selected are displayed in 
grey.
A small pop-up window containing explanatory information will also appear whenever 
you place the mouse cursor on any Work bar button. The Work bar buttons are 



explained in the description of the corresponding functions (see The Menu bar). 
Dependent on the AND Route road network purchased, there are up to five Work bars: 
The Route work bar, the Overview work bar, the Map work bar, the Files work bar, and 
the Auxiliary work bar.

In addition to the Input fields and the five Work bars, the File library, containing the 
road networks you have purchased, is also found under the Menu bar. Each file is 
identified by its own clearly recognisable icon. If you are using the UK version of AND 
Route '97 for the first time, start the application with the UK road network. Start the 
European version of AND Route '97 for the first time with the European road network. 
The next time you open AND Route '97, the most recently used road network will 
appear automatically.

Most of the default Main window is given to the Route overview displaying journey 
instructions. The remainder of the Main window displays the Map of your selected road 
network.

The routes in the Route overview each have their own Tab sheet. The standard display 
shows the optimal route. The alternative routes can be displayed by clicking the 
appropriate Tab sheet. You determine the amount of detail displayed in the information 
in the Route overview yourself, by selecting a specific detail level (see The route-
overview for additional information).

The map will display your chosen departure and arrival points and the calculated routes. 
The optimum route will be in heavy colour with any alternative routes in shaded.

The Status line, which actually consists of two components, is displayed at the very 
bottom of the Main window.
The left-hand side of the Status line displays an explanation of the menu command or 
button on which the cursor is placed. The right-hand side of the Status line displays the 
selected departure and arrival points, the total distance between those points, and the 
duration of the selected route. This information changes as alternative routes are 
selected or new routes are calculated. Between the departure and arrival point you will 
find the button . By clicking this button, a special dialogue window will appear in which 
you can select and add via's along the route. This dialogue window can also be opened 
by selecting the command `Selecting via's along the route' in the Route menu.

The layout of the Main window described above is the standard layout. The appearance 
of the Main window can be changed to meet your individual requirements. The Work 
bars and the File library, for example, which are found under the Menu bar in the 
standard window layout, can both be placed directly in the Main window. The Route 
overview can also be moved, or even adjusted in size. Note: moving elements in the 
Main window is practical only if your monitor is larger then 14 inches. If your monitor is 
14 inches or smaller, you will probably want to streamline the Main window by 
concealing certain elements (see Changing the layout of the Main window for additional 
information).



Using AND Route '97
Many functions within the application can be executed in a variety of ways: via the Menu 
bar, via an icon on one of the Work bars and via the right-hand mouse button. The right-
hand mouse button can be used only in the Map or in the Route overview. Clicking this 
button will cause a number of options, relevant to your current location within the 
application, to appear.
The following sections contain descriptions of all of the options offered by the various 
functions, and are explained in chronological order. Additional information is available 
via the help files, which can be activated simply by pressing F1.

Selecting a file
Selecting departure and arrival points
Selecting from a list containing specific types of locations
Selecting from a list of all types of locations
Selecting Via's along the route
Calculating routes
The Route overview
The Map
Example



Selecting a file
When using AND Route '97 the first time, it will open with the individual road network 
that you have just purchased and installed. When you have more than one AND Route 
road network installed , any subsequent sessions will, for your convenience, open with 
the road network that was previously used.

Should you have two, or more, AND Route products, selection of a different road 
network can be achieved in a variety of ways:

(1) Via the File menu:
a) Select 'Open' in the File menu. A dialogue window in which the appropriate file can be 
selected will appear. The file selected will be opened immediately and the appropriate 
icon will be placed in the File library.
or
b) Select the desired file from the File list in the File menu.

(2) Via the File library: Click the icon of the file desired in the File library.

(3) Via the Open file icon . Clicking this icon will cause the Open file dialogue window 
to appear. Select the desired file in this window. Click 'OK' to open the file and have the 
icon placed in the File library.

(4)Via the Windows File Manager: Go to the File Manager, select the desired file and 
drag it to the Main window of AND Route '97. Do this as follows: place the mouse cursor 
on the desired file, depress and hold the left-hand mouse button , and release when you 
reach the Main window of AND Route '97. The dragged file will be opened immediately, 
and the associated icon will be placed in the File library.

Note: Only one road network at a time can be activated in AND Route '97.



Selecting departure and arrival points
Prior to setting a departure and arrival point you may, depending on the AND Route 
network purchased, have the option to limit the number of locations to specific choices 
such as railway stations, airports or border crossings.

See the following topics for additional information:
Selecting from a list containing specific types of locations
Selecting from a list of all types of locations
Selecting Ferry Routes



Selecting from a list containing specific types of locations
Use the Find locations dialogue window to limit the locations displayed for selection to a 
specific type of location. This window can be activated as follows:

· select 'Find locations...' in the menu under the right-hand mouse button (while the 
cursor is over the Map or the Route overview)

· click the Find locations icon 
· select 'Find locations...' in the Edit menu.

The Find locations dialogue window will appear. Select from the Restriction lists on the 
right-hand side. These lists will normally display the words 'No restrictions'.
If, for example, you wish to select a railway station as departure location, and you wish 
to display the entire list of possible locations from which to select an arrival point, you 
would:

(1) Open the top Restriction list by clicking the arrow. You may then be offered    a 
choice of sub groups including:

- no restrictions
- railway stations
- border crossings
- airports

(2) Click 'railway stations'.
Open the list of departure locations. Only locations which are railway stations are 
displayed.

(3) Select the station desired.

(4) Type your arrival point directly into the Input field or select it from the list of locations, 
since the restriction is still correctly set to 'no restrictions'.

(5) Click 'Calculate' to have the route calculated. Click 'Close' if you wish to quit the 
window without having the route calculated.



Selecting from a list of all types of locations
Selecting a departure and arrival point from the 'all' locations listing can be carried out in 
a variety of ways. First of all, you can use the Input fieldswhich are located under the 
Menu bar. (Even if you do choose to use another selection method, your departure and 
arrival points will be displayed in these Input fields). The methods differ only in that you 
may place the locations in the Input fields directly or indirectly. The various methods are 
described below.

The Input fields
Type a location in the Input field and confirm your selection with <Enter> or select the 
location from the drop-down list. The list can be opened by clicking the arrow next to the 
Input field or by pressing <Down arrow>. These two methods can also be combined, 
which is particularly useful if you are not sure of the exact spelling of a given location. 
Type the first few letters of the location name in the Input field and then open the list. All 
of the locations beginning with the letters you have entered will be displayed.

Besides entering city and town names as locations, you may also be able to enter 
railway stations, border crossings, etc. Before entering something other than a city as 
the location desired, check the notation conventions for the type of location you wish to 
enter. UK railway station names always begin with 'BR'. A railway station in London, for 
example, would be listed as 'BR London Kings Cross'.

Other location input methods

Selecting locations
Locations can be selected in the Map using the following method:
· Position the mouse cursor at the approximate geographic position of the desired 

location on the Map
· Press <Shift> and click the left-hand mouse. The locations in the nearby vicinity of 

the mouse cursor will now appear in a list. Note: this may take some time on 
relatively slow computers and this method works only if your cursor is positioned 
above land.

· Select a location from the list.

You can also select a location from the Route overview. Place the mouse cursor on the 
location in the Route overview and click, or use the cursor keys to move to the desired 
location.

Transforming the selected location into a departure or arrival point
Once you have selected a location, the location must be transformed into a departure 
point or arrival point appearing in one of the Input fields.
This can be accomplished in a number of ways:

· Select '<selected location> as departure' or '<selected location> as arrival' in the 



menu under the right-hand mouse button (while the cursor is over the map or Route 
overview)

or
· click one of the corresponding icons (  or 

)
or
· select the command 'selected location as departure' or 'selected location as arrival' 

in the Route menu.

The chosen location will now appear in one of the Input fields.



Selecting Ferry Routes
For your convenience, ANDRoute '97 lists most major ferry crossings which allow you to 
create a customised route, via a preferred ferry, if you wish.
Listed ferry crossings can be selected and entered into an overall journey as Via's. If, for 
example, you wish to travel from Oxford, United Kingdom, to Lisbon, Portugal -via the 
Plymouth-Santander Ferry- you would proceed as follows:

1. Enter Oxford (GB) as Departure and Lisbon (P) as Arrival in the main location input 
fields.

2. Open the `Select Via's along the route' dialogue window, for example by clicking 

1. Type `Ferry Plymouth' and select `Plymouth-Santander' from the drop-down list 
of locations.

1. Press <Insert> to place the selection into the current route dialogue between 
Oxford (GB) and Lisbon (P).

1. Press `Calculate' to produce an optimum route plan to your destination via this 
ferry route.

1. Press `Close' to exit the dialoque window.

Hint: Ferry operations can fluctuate from day to day and are, in some cases, seasonal 
services. To assist trip scheduling, we recommend that you check with your travel agent, 
or ferry company, to ascertain which services are operating and the typical crossing 
duration, including approximate boarding and debarking times, on those dates you are 
planning to travel.



Selecting Via's along the route
You may want to visit additional locations on your journey by selecting a departure and 
arrival point, and one or more locations along the route. AND Route `97 will calculate 
the optimal route (with possible alternatives) and include these additional locations in 
your journey plan. You can open the Selecting via's along the route dialogue window in 
a number of ways:

· Choose `Via's along the route add/delete' in the menu under the right mouse button 
(while the cursor is over the Map or the Route overview)

or

· click on 
or
· click on 
or
· choose the command `Select Via's along the route' in the Route menu.

The Via's-along-the-route-dialogue window will appear now. Open the list of locations by 
clicking the arrow. Select the desired intermediate location from the list and click `Add' 
to include this location in the present route. Repeat this for every intermediate location 
you want to visit on your way. A location can always be deleted by highlighting it and 
clicking `Delete'.

Select 'Calculate' to continue or 'Close' if you want to leave the dialogue.

New Via's will always appear below whatever current route location entry is highlighted. 
To enter Via's in a particular sequence, simply change the highlighted entry.



Calculating routes
A variety of route calculation prompts are available:

If you used the Find locations dialogue window to select the desired locations, you can 
proceed by clicking 'Calculate'.

If you used another method to select the desired locations, and those locations are now 
displayed in the Input fields , you can calculate the route as follows:

· Select 'Calculate route' in the menu under the right-hand mouse button (while the 
cursor is over the Map or the Route overview)

or
· click the corresponding icon 
or
· select the command 'Calculate route' in the Route menu.



The Route overview
Once a route has been calculated, directions for the optimal route will appear in the 
Route overview. The Map will display all proposed routes including any possible 
alternatives. 

The Route overview consists of four columns. The first column shows the departure 
location and points which you will pass during the course of your journey. The second 
column displays the road numbers . The third column the distances between each of the 
points. The approximate duration of the journey is displayed in the fourth column.
The total distance and the expected duration are permanently displayed on the Status 
line next to the departure and arrival points.

Dependent on the actual journey, the Route overview allows you to view any alternative 
routes that may be available (a maximum of two) by clicking on additional Tab sheets. 
These routes would be the best alternatives to the optimal route. You can navigate 
through the Route overview with the help of either the cursor keys or the Scroll bar.

AND Route '97 allows you, via four route information presentation levels, to determine 
the amount of detail in which the route information is presented: level 1 provides you 
with the least detail, while level 4 provides you with the most detail. In addition, AND 
Route '97 enables you not only to have the entire route presented in varying levels of 
detail, but also to request additional detail, or limit the amount of detail provided, for a 
specific section of the route, at whatever level of detail you desire. Each of the lines in 
the Route overview represents a 'section' of the route. There are three ways in which to 
select the level of detail for the presentation of route information - and to request 
additional detail, or less detail, for a specific section of the route:

- Place the mouse cursor on the Route overview display and select `Fold section' or 
`Unfold section'desired in the menu under the right-hand mouse button

or

- Highlight any + or - in the Route overview and double click the left-hand mouse button

or

- Select the menu command desired in the Route overview menu.

In addition to allowing you to specify the level of detail, AND Route '97 also allows you 
to specify whether you want cumulative or non-cumulative route information. This 
information is normally displayed cumulatively, but this can be changed by clicking the 
Non-cumulative icon  in the Route overview work bar, or by selecting 'Non-cumulative 
description' in the Route overview menu. Click the Cumulative icon 

 or select 'Cumulative description' if you wish to re-display the information 
cumulatively.



Alternatively, you may use the menu under the right-hand mouse button, while the 
cursor is over the Route overview, and select the desired option.



The Map
The Map graphically displays the calculated route from the departure point to the arrival 
point. In addition to being able to select arrival and departure locations directly from the 
map, you may also zoom in and zoom out at various levels, and redisplay the route or 
the entire Map with a single command (useful if you have zoomed in to a very high level 
of detail).
You can also highlight an area to be enlarged by simply 'dragging' the cursor diagonally 
over the map while depressing and holding the LH mouse button. The map area within 
the box created will quickly be redrawn to larger scale.

There are also three other ways to zoom in for greater detail on the Map, or to zoom out 
for a better overview:

· Select the desired zoom command in the menu under the right-hand mouse button 
(with the cursor over the Map

or
· Select the desired zoom command in the Map menu
or
· Use the buttons on the Map work bar: , 

, 
, 



Example
The way in which AND Route '97 works is best explained based on an example.

Our example is based on use of the AND Route '97 UK road network, which allows us to 
enter postal areas as locations. Postal areas can consist of four or five numbers, e.g. 
EH10.5 Edinburgh. Let us assume that you wish to drive from Edinburgh, postal area 
EH10.5 , to Oxford.
These locations can be entered in a variety of different ways. We will use the Input fields 
to select the departure and arrival points, and the Route work bar to have the route 
calculated.

Do the following:
Go to the Input field for the departure location by clicking with the mouse or by pressing 
<Tab> until you reach the desired Input field. Type EH10.5 Edinburgh in this Input field. 
Confirm your entry by pressing <Enter>. The cursor will now automatically jump to the 
Input field for the arrival point. Type Oxford in this field and press <Enter>. You might 
also enter both locations by making use of the drop-down list of locations (e.g. type 
`Edinburgh' and then select `EH10.5').

Go to the Route work bar and click the Calculate route icon . The application 
calculates the route information. The description of the optimal route appears in the 
Route overview and the corresponding route appears on the Map. In addition, two 
alternative routes have been calculated, which are displayed if you click the Tab sheets 
'1st Alternative' and `2nd Alternative'.

Both the optimal and the alternative route descriptions contain the following information:
The departure location, 'EH10.5 Edinburgh appears at the top of the description, while 
you can see the arriving location, Oxford, at the end of the description. The crossings, 
exit ramps, etc. which you will come across on your journey between 'EH10.5 Edinburgh 
and 'Oxford' are displayed, followed by the road designations of your route. The 
application also provides you with information on the length of each section of the route 
and the approximate duration of the journey over each of those sections.
The Status line at the very bottom of the screen displays the departure and arrival 
points, the total length of the route in miles and the approximate duration of the entire 
journey.



Special features of AND Route '97
AND Route '97 offers several other special features:

Changing the layout of the Main window
Cutting, copying and pasting
Printing
Mail
Preferences



Changing the layout of the Main window
The layout of the Main window can be changed very easily to meet your individual 
needs. You can determine, for example, whether or not you want the following elements 
to appear on your screen as part of the Main window:

Route work bar
Route overview
File library
Map work bar
Overview work bar
Legends
Files work bar
Auxiliary work bar

One or more of the elements mentioned above can be revealed, or concealed, in the 
Main window by clicking the appropriate element or elements in the Window menu.

You can also move these elements within the Main window. Normally, these elements 
are located at 'fixed' points in the Main window, but they can also be 'floating'. Note: the 
Map is the only element of the Main window which cannot be moved and which cannot 
be concealed.
Elements can be moved as follows:

· Place the mouse cursor on the element you wish to move
· Press the left-hand mouse button. The edge of the element you wish to move will 

become vague.
· Hold the mouse button in and move it in the direction you wish to move the element. 

As you move the mouse, the element will display a vague, thick edge, which means 
that the element is disconnected from the Main window.

· Release the mouse button when you have reached the desired position in the 
screen. The element will be fixed into its new position in the Main window. If you 
have moved the element in such a way that part of it falls outside of the screen, the 
application will automatically move it so that the entire element is displayed.

Floating elements tend to click themselves back onto the Main window rather quickly. 
This can be prevented by disconnecting the element from the Main window, as 
described above, and then pressing <Ctrl>. This will cause the element to become a 
separate window instead of being connected to the main window.

The Split bar between the Map and the Route overview can be moved to create more 
space for either one.

You may return to the standard layout at any time simply by clicking 'Standard window 
layout' in the Window menu, or by clicking the corresponding button on the Route work 
bar.



Your new Main window layout is automatically saved when you close AND Route '97.



Cutting, copying and pasting
The availability of the various options in the Edit menu is dependent on the element of 
the application which you are using at that time: If, for example, you are in the Map or in 
the Route overview, only the 'Copy' command will be available. This command can then 
be used to copy the Map or the route information displayed to the Clipboard. The Map 
or the route information can also be copied directly from the Map or the Route overview 
by selecting 'Copy route description/map' in the menu under the right-hand mouse 
button.
If you are in an Input field, all edit commands can be used: the command 'Cut selected 
text' removes any text from the Input field, 'Copy Map/Route description/Selected text' 
copies the Map, Route description or selected text to the Clipboard, and the command 
'Paste text' places the contents of the Clipboard in the Input field. In the last case, 
whether or not the pasted text can be used in AND Route '97 depends on whether the 
pasted location actually appears in the list of locations.



Printing
In addition to allowing you to determine the level of detail of the information printed, 
AND Route '97 also allows you to determine which information you want printed (see 
The Route overview for additional information). To determine the information to be 
printed select the command 'Print' in the File menu, or click the Print icon . A dialogue 
window with two Tab sheets will then appear, one for the items which you wish to print, 
and one for the level of detail. Click the Tab sheet you desire. The 'Items' Tab sheet can 
be used to print both the route information, for one or more routes, and the Map. When 
printing route information, you may select the routes you wish to print: i.e. one or a 
combination of optimal and alternative routes.
The 'Level of detail' Tab sheet can be used to set the level of detail printed. Closing the 
Tab sheet with 'OK' saves the settings of both Tab sheets.
Once you have closed the Tab sheets with 'OK', the Print dialogue window will appear.



Mail
The route information or map, or both, can be mailed immediately by simply selecting 
the command 'Mail' in the File menu, or by clicking the Mail icon . The dialogue 
window which then appears can be used for both mailing and printing (see Printing for a 
complete description of how this dialogue window works). Instead of 'print', enter 'mail' 
in this dialogue window to mail the desired information. The text of the route 
descriptions is mailed exactly as you see it on your screen. Maps however, are mailed 
as separate .bmp files.
Once you have closed the Tab sheets with 'OK', the dialogue window of Microsoft Mail 
or another mail software package will appear.

Note: 'Mail' works only if you run Windows 95 or Windows NT and if you possess a mail 
package. If you do not possess a mail package, 'Mail' will not appear in the File menu 
as a menu command and the Mail icon will be displayed in grey.



Preferences
Many of the settings of AND Route '97 can be changed to meet your individual 
requirements. Settings can be changed by selecting the command Preferences in the 
File menu, or by clicking the Preferences icon  in the Files work bar. 

This relates to the following:

the level of Map detail: Click the Tab sheet 'Map level of detail'. You can select any of 
five levels of detail. If you select 'Automatic', the application will automatically select the 
level of detail which best corresponds to the scale selected.

the colours of the Map: Click the Tab sheet 'Map colours' to change the colours in which 
land, cities and water are presented. Click 'Change' to select a new colour. 'Back' can 
be clicked at any time to undo your selection.

the print font: Click the Tab sheet 'Print font' and select the font and font size desired. 
The selected settings will be used when printing route information.

Road colours: Click the Tab sheet `Road colours' to adapt the colour and width of the 
different kind of roads and calculated routes.
First select the road or route which you want to change by clicking the corresponding 
button. On clicking `Change colour', a colour dialogue window will appear in which you 
can select an alternative. After clicking on `Change width', you can enter a new width in 
the adjacent input box. You can undo your choices by clicking `Back'.

Closing a Tab sheet with 'OK' will save the settings for all Tab sheets.



The Menu bar

The menus on the Menu bar contain all of the functions of AND Route '97. The following 
section contains a brief description of all of these functions.

File...menu
Edit...menu
Route...menu
Map...menu
Route overview...menu
Window...menu
File...menu



File...menu
Open or 
Opens a road network file and places it in the File library.

Print or 
Opens a dialogue window with two Tab sheets which can be used to select your 
preferences for print and mail settings. Once the Tab sheets have been closed with 'OK', 
the Print dialogue window will appear (see Printing for additional information). 

Print example
Opens a dialogue window with two Tab sheets which can be used to select your 
preferences for print and mail settings. Once the Tab sheets have been closed with 'OK', 
the print example with the selected settings will appear on your screen.

Mail or 
Opens a dialogue window with two Tab sheets which can be used to select your 
preferences for print and mail settings. Once the Tab sheets have been closed with 'OK', 
the dialogue window of your mail software will appear (see Mail for additional 
information).

Preferences or  
Opens a dialogue window with four Tab sheets which can be used to change a number 
of the settings used by AND Route '97: the level of detail , road colours, map colours, 
and the font size used when printing (see Preferences for additional information).

File list
AND Route maintains a list of the files you opened most recently to a maximum of eight, 
allowing you to easily open the files you (probably) use most frequently.

Close
Closes AND Route '97.



Edit...menu
Cut selected text
Cuts text from the selected Input field.

Copy Map/Route description/Selected text
Copies the Map, the Route description or the selected text to the Clipboard. The Main 
window element active at the moment this command is invoked (Map, Route overview 
or Input field) determines what is copied.

Paste text
Pastes text from the Clipboard into the selected Input field. Whether or not the pasted 
text can actually be used in AND Route '97 depends on whether or not the location 
actually appears in the list of locations.

Find locations... or 
Opens the Find locations dialogue window. This window is used if you wish to see only 
specific locations, e.g. only railway stations. See also Selecting from a list containing 
specific types of locations.



Route...menu
Calculate route or 
Calculates the optimal route, based on your selected departure and arrival points.

<Selected location> as departure or 
Makes the selected location the departure point for route calculation.

<Selected location> as arrival or 
Makes the selected location the arrival point for route calculation.

Selecting Via's along the route or 
Shows a dialogue window in which you can enter locations you want to visit on your 
journey. The program calculates the optimal route (with possible alternative routes), 
from the departure to the arrival point including these via's along the route.



Map...menu
Zoom in or 
Zooms in on the centre of the Map. You can zoom in several times.

Zoom out or 
Zooms out from the centre of the Map. You can zoom out until the entire Map becomes 
visible.

Entire map or 
Places the entire Map in the Main window with a single command.

Zoom to the route or 
Places the entire route in the Main window with a single command.



Route overview...menu
Unfold to level 1
Displays the route information contained in the first (least detailed) level.

Unfold to level 2
Displays the route information contained in the first and second (more detailed) levels.

Unfold to level 3
Displays the route information contained in the first, second and third (relatively 
detailed) levels.

Unfold to level 4
Displays the route information contained in the first, second, third and fourth (most 
detailed) levels.

Unfold section
Displays more detailed route information for the section selected, i.e. the line selected in 
the Route overview at the moment this command is invoked.

Fold section
Displays the standard route information for the section selected, i.e. the information 
which is normally displayed in the Route overview after calculation of the optimal route.

Cumulative description or 
Provides a cumulative description of the route information displayed.

Non-cumulative description or 
Provides a non-cumulative description of the route information displayed.



Window...menu

Standard window layout or 
Returns the Main window to the standard layout.

The remaining commands in this menu enable you to reveal or conceal certain 
elements of the Main window by simply clicking the element you wish to reveal or 
conceal. A check mark next to the element in the menu tells you whether the element is 
visible or invisible.

The following elements can be revealed or concealed:

Route work bar
Route overview
File library
Map work bar
Overview work bar
Legends
Files work bar
Auxiliary work bar



Help...menu
Contents or 
Gives you access to the AND Route '97 Help file. The command Contents provides you 
with a section-by-section overview of the topics available in the Help file.

Search
Provides an alphabetical list of all of the topics available in the Help file.

Using Help
Provides a general introduction to the use of the Help file.

About AND Route '97
Provides information on the version number of AND Route for Windows, information on 
copyrights, and information on your computer.



Methodology used to calculate route information
Calculation of route information is based on road networks, which are a combination of 
road segments. AND Route '97 contains information on the type of road making up each 
road segment, e.g. motorway, as well as information on the average speed of traffic 
travelling on these segments. Each type of road is also associated with a given priority 
based on the desirability of travelling on the type of road involved. When determining 
the quickest route, the application takes the priority associated with the various roads 
into account, as well as the average speeds of the various types of roads. The speeds 
and priorities associated with the various roads cannot be changed.



Help desk
The UK Help desk is available between 9.00 AM and 17.00 PM, Monday to Friday on 
01865 244100.
It can also be reached at the following fax number: 01865 200877, or by e-mail on 
help@andtech.co.uk

In the event of problems with the use of AND Route, please ensure you have mailed 
your registration card, and that you can provide the following information:

· The problem you have experienced
· Your computer's brand name and type
· The type of monitor (video card) you are using
· The amount of free working memory (this can be checked with the help of 'About 

AND Route '97' in the Help menu)
· The Windows version you are using



Network licences and commercial licences
Please contact AND Electronic Publishing, Oxford, UK, tel. 01865 200800, for network 
licences and commercial licences. Note: Support requests cannot be handled at this 
number!
Network licences and commercial licences can also be ordered via the fax number 
mentioned above.



AND Electronic Publishing

AND Electronic Publishing is the sales and marketing operation of AND International 
Publishers plc.

AND was established in Rotterdam in 1984 and has since then grown into an 
internationally active software company with offices in England (AND Technology Ltd), 
the United States (AND Software Inc.), Hungary (AND Software Kft.), Germany (AND 
Software GmbH), Spain and the Netherlands (AND Mapping B.V., AND Identification 
B.V., AND Plangroep B.V., AND Operations Research B.V. and AND Publishers B.V.).

Other AND titles available in the United Kingdom include:

AND Route '97 Europe AND Travel Series

AND Route '97 UK & Ireland AND Travel series

AND MileageMinder AND Travel Series

Forthcoming releases:

The World English Dictionary AND Reference Series

Museums on the Map AND Travel Series

ContactsManager AND Travel Series




